
File Menu

New
Open
Save As
Close
Print
Address Book
Profile
Capture
File Transfer
Import Text
Export Text
Exit



New command

Opens a window to create a new file.



Open command

Opens an existing file.



Save As command

Saves the current file to a user specified name.



Close command

Closes the current window.



Print command

Prints the current window.



Profile command

Opens the Profile dialog box to change and create profiles.



Capture command

Opens a new file to capture data as it is transmitted to the Terminal window.    If you already have a file 
open, use this command to turn the file off, or open a new file.



File Transfer command

Opens the Transfer File dialog box to upload or download a file.



Import Text command

Inserts the selected file at the cursor position in the current window.



Export Text command

Exports the current window to the selected file.



Exit command

Closes InterNav.



Edit Menu

Undo
Cut
Copy
Copy Append
Paste
Paste Formatted
Paste Quoted
Select All



Undo command

Undoes the most recent editing action.



Cut command

Moves the marked text onto the Clipboard.



Copy command

Copies the marked text onto the Clipboard.



Copy Append command

Copies and appends the marked text to text already in the Clipboard



Paste command

Inserts the text from the Clipboard at your current cursor position.



Paste Formatted command

Inserts the text from the Clipboard at your current cursor position.    The text will be formatted as a single 
paragraph.



Paste Quoted command

Inserts the text from the Clipboard at your current cursor position.    The text will be formatted as a single 
paragraph and each line will begin with the Quoting String.



Select All command

Marks the entire file.



Connection Menu

Log On Auto
Log On Manual
Register
Log Off



Log On Auto command
Opens the communication port, and executes the Logon Script to sign on DELPHI.



Log On Manual command
Opens the communication port, and Terminal window.



Register command
Runs the registration script to set up a new DELPHI account.



Log Off command

Executes the Logoff script to sign off DELPHI.



Options Menu

User Info
Phone Number
Colors
Fonts
Macros
Preferences
Port
Modem
ComEngine



User Info command
Opens the User Info dialog box to set your username and password.



Port command
Opens the Port dialog box to set the port, speed, and frame parameters used.



Modem command
Opens the Modem dialog box to set the modem command codes used, such as the initialization string.



Phone Number command
Opens the Script dialog box to set the phone number and scripts used.



Colors command
Opens the Color Preference dialog box to select the colors used by InterNav.



ComEngine command
Opens the ComEngine dialog box to set the variables used by the communication engine.



Fonts command
Opens the Fonts dialog box to set the fonts used in the various windows.



Macros command
Opens the Editor Macros dialog box to set the signature and tag lines used when composing messages.



Preferences command
Opens the Preferences dialog box to set the tiling and word wrapping of windows, message width, and 
the display of the status bar and LED simulation.



Window Menu

Close All
Tile Vertical
Tile Horizontal
Cascade
Arrange Icons
Terminal



Tile Vertical command

Arranges open windows side by side.



Tile Horizontal command

Arranges open windows below each other.



Cascade command

Arranges open windows on top of each with the title bars showing.



Arrange Icons command

Arranges the minimized windows according to the values set in Control Panel's Desktop.



Close All command

Closes all document windows.



Terminal command

Opens the Terminal window.



View Menu

Terminal
Mail
Go To



Terminal command

Opens the Terminal window.



Mail command

Will enter the Mail system where you can send and receive private e-mail messages to DELPHI 
members or users on the Internet.



Go To command

Opens the Go To list of your favorite locations.



Address Book command

Opens the E-mail Address Book to add usernames.



Go Main command

Displays the DELPHI Main menu.



Internet command

Displays the Internet Services Menu.



Mail Menu

Read Message
New Message
View Folders



New Message command

Opens a Send window to send a new mail message.



View Folders command

Opens the Folders window which displays a list of your new and read mail messages.



Help Menu

Contents
Search For Help On
How To Use Help
About



Contents command

Opens the help system with the InterNav Help Table of Contents displayed.    The contents lists the 
procedural topics (how to's), followed by commands, and the tool bars.



Search for Help On command

Opens the help system in Search mode.    You can also initiate a search by first marking a string of text, 
such as a command name in a script, and if a help topic exists that matches the search string, the topic 
will be displayed automatically.



How To Use Help command

Opens the help system and displays the topics for learning how to use the help system.



About command

Displays the version information.





InterNav Help Table of Contents

Using Help Product Support
Using InterNav

General
InterNav Basics
DELPHI Account Registration
Connecting To DELPHI
Disconnecting from DELPHI
Navigating DELPHI Menus
Moving Around Quickly with Go To
Capturing Text
Posting Messages On-line
File Transfers
Conferencing on DELPHI

E-mail
Entering and Exiting E-mail
Sending Messages
Reading Messages
Replying to Messages
Forwarding Messages
Saving Messages
Deleting Messages
Adding Names to the Address Book
DELPHI Storage Limitations

Editing in InterNav
Copying Text
Using Edit Windows
Custom Editing Features
Edit Window Formatting
Importing Text Files

The Internet
InterNav and the Internet
Registering for Access
Internet E-mail
Gopher Menus
Usenet Discussion Groups
Telnet
FTP
Internet Relay Chat (IRC)
The Internet Services Menu

Advanced Features
Creating InterNav Profiles



Assigning Accelerator Keys
Adding Locations in Go To
Script Language Reference

Pull-Down Menus
File Options View
Edit Window Mail
Connectio

n

Tool Bars
Off-line Options
On-line Mail



The User Information is used to supply your username and password when logging (signing) on 
DELPHI.



Verification
Enter your DELPHI password again in this field to validate it.

NOTE:    Leave this field blank if you prefer to be prompted for your password each time you log on.



Username [Script Variable:    $(UserID)]
Enter your DELPHI username.    This data is used to answer DELPHI's "Username" prompt.



Password[Script Variable:    $(Password)]
Enter your DELPHI password.    This data is used to answer DELPHI's "Password" prompt.

NOTE:    Leave this field blank if you prefer to be prompted for your password each time you log on.



The Port Settings are used to establish communication between InterNav and your modem.



Port

Click on the  to open the list box and select the port your modem is connected to.



Baud Rate

Click on the  to open the list box and select the baud rate to use.



Data Bits

Click on the  to open the list box and select the number of data bits to use.

NOTE:    This should usually be set to 8.



Parity

Click on the  to open the list box and select the parity to use.

NOTE:    This should usually be set to None.



Stop Bits

Click on the  to open the list box and select the number of stop bits to use.

NOTE:    This should usually be set to 1.



OK
Select this button to exit the dialog box and save the changes you have made.



Help
This button displays the help topic you are currently viewing.



Cancel
Select this button to exit the dialog box and ignore any changes you may have made.



The Modem Settings are used to describe how InterNav should communicate with your modem.    
InterNav's scripts use these codes to perform the commands necessary to log on and off of DELPHI.
For a list of some generic commands used by most modems, refer to Common Hayes Commands.    
Consult your modem's user guide for commands specific to your modem.

NOTE:    If a modem command consists of a \ character, you must enter two backslashes.    For example,
to enter \J0 in the Setup field, you would type \\J0.



Attention [Script Variable:    $(CodeAT)]
The attention code is the command used to indicate the start of a command line.



Escape [Script Variable:    $(CodeEscape)]
The escape code changes the modem from on-line to command state.



OK [Script Variable:    $(ResultOK)]
This is the string that is returned by the modem when a command is completed successfully.



Connect [Script Variable:    $(ResultConnect)]
This is the result code returned when a connection is completed.    The code returned by your modem 
will be based on the result code (Xn) set used under the Setup Command.



Dial [Script Variable:    $(CmdDial)]
The command used to dial the modem, such as DT for touch tone, or DP for pulse dialing.



Hangup [Script Variable:    $(CmdHangup)]
The command used to hang up your modem.



Setup [Script Variable:    $(CmdSetup1)]
This is the initialization string to use during start up.    The field supports up to 127 characters, but your 
modem may not support this length.

NOTE:    If a modem command consists of a \ character, you must enter two backslashes.    For example,
to enter \J0 in the Setup field, you would type \\J0.



Reset [Script Variable:    $(CmdReset)]
The command used to reset the default modem settings.



The Script Settings are used to provide the necessary information to log (sign)on to DELPHI.



Tymnet
Click on this button to automatically select the default settings for this dialog box that are normally used 
when logging on DELPHI using Tymnet.    The only setting you will need to edit is the Phone Number.



Sprintnet
Click on this button to automatically select the default settings for this dialog box that are normally used 
when logging on DELPHI using Sprintnet.    The only setting you will need to edit is the Phone Number.



Direct
Click on this button to automatically select the default settings for this dialog box that are normally used 
when logging on DELPHI using the direct access line.    The only setting you will need to edit is the 
Phone Number.



Logon

Click on the  to open the list box and select the script to use when calling DELPHI.

If you are prompted with 'please log in:' which is Tymnet's prompt, select logontym.bmc.
If you are prompted with '@', which is Sprintnet's prompt, select logonspr.bmc.
If you are prompted with, 'Local>'which is DELPHI's prompt, select logondir.bmc.



Logoff

Click on the  to open the list box and select the script to use to when signing off DELPHI.

If you use a Tymnet node to access DELPHI, select logoftym.bmc.
If you use a Sprintnet node to access DELPHI, select logofspr.bmc.
If you call DELPHI at the direct access number, select logofdir.bmc.



Display Script Processing          No
Select this button if you do not want the terminal window opened when a script is executed.



Display Script Processing          Yes
Select this button if you want the terminal window opened to watch as commands are executed by the 
script.



Access Number [Script Variable:    $(PhoneNumber)]
Enter the phone number you use to call DELPHI.    Please be sure to include 1 and the area code, if 
applicable.



Prefix [Script Variable:    $(DialPrefix)]

Enter your dial prefix if one is required.    For example, if you are using a phone system that requires you
to dial 9 to get an outside line, then enter the number 9 followed by a comma in this field.    If the line you
are using has a call waiting feature, you should enter *70 followed by a comma to prevent interruptions 
during your DELPHI session.    If you do not use a dial prefix, then leave this field as is with the comma.



Access ID [Script Variable:    $(NetworkID)]
This is generally delphi.    However, if the access method you use requires something other than 'delphi',
enter that text in this field.



Network Prompt [Script Variable:    $(NetworkPrompt)]
Enter the text the network prompts you with when asking for the service you wish to log on to.
If you use a Tymnet node to access DELPHI, enter in:.
If you use a Sprintnet node to access DELPHI, enter @.
If you call DELPHI at the direct access number, enter Local>.

NOTE:    The correct data for this field will be entered automatically if you are using the logontym.bmc, 
logonspr.bmc, or logondir.bmc scripts.



End of Line [Script Variable:    $(CommE0l)]
This is the line terminator used to terminate lines of text sent to DELPHI.    It defaults to carriage return (\
r).



Name Prompt [Script Variable:    $(NamePrompt)]
The text DELPHI uses to ask you for your username. (Username:)



Password Prompt [Script Variable:    $(PasswordPrompt)]
The text DELPHI uses to ask you for your password. (Password:)



Trigger String [Script Variable:    $(TriggerString)]
The text used to indicate that DELPHI is logging you on. (on:)



Wakeup Char [Script Variable:    $(WakeupChar)]
A character that signifies you have established a connection with the network.    (?)
NOTE:    This variable is only applicable to Tymnet.    The front-end uses a question mark (?) to indicate 
invalid characters.    Since Tymnet usually sends its "please enter terminal identifier" prompt at 300 baud,
all characters in that prompt will be invalid, thus they will be replaced with question marks.    If you can 
see the terminal identifier prompt, use one of the characters that appear in the prompt, such as 'p'.



Wakeup Resp [Script Variable:    $(WakeupResponse)]
This is your terminal identifier. (a)
NOTE:    This is only applicable to Tymnet.



The Font Preferences determine the font used to display data.



Display Font
Click on this button to select the font used when displaying text that has been received, such as mail 
messages.



Edit Font
Click on this button to select the font used while you are composing messages.



This area will display the font name and the actual size of the font selected for the Display Font.



This area will display the font name and the actual size of the font selected for the Edit Font.



Terminal Font
Click on this button to select the font used in the Terminal window.



This area will display the font name and the actual size of the font selected for the Terminal Font.



Tool Bar Font
Click on this button to select the font used for the tool bar.



This area will display the font name and the actual size of the font selected for the Tool Bar Font.



Status Bar Font
Click on this button to select the font used for the status bar.



This area will display the font name and the actual size of the font selected for the Status Bar Font.



VT100 Font
Click on this button to select the font used in the VT100 Terminal window.



This area will display the font name and the actual size of the font selected for the VT100 Font.



The Preferences settings determine where windows are positioned, and word wrapping within the 
windows.



Tool Bar Options

Click on the  to open the list box and select your preference for the display of the tool bar.

None turns the display of the tool bars off.
Full Buttons will display both the icon and label.
Labels Only will display just the text name of the command.
Icons Only will display just the picture of the command.



Auto Window Arrange

Click on the  to open the list box and select the way you prefer windows displayed when they are 
opened.

None will place each new window on top of the previous window.
Cascade will place each new window below the title bar of the previous window.
Tile Horizontal will place each new window below the previous window.
Tile Vertical will place each new window along the side of the previous window.



LED Simulation

Click on the  to open the list box and select either the color you prefer for the modem LED simulation, 
or turn off the simulation by selecting None.



Display Status Bar - No
Select this button to turn off the display of the status bar.



Display Status Bar - Yes
Select this button if you want the status bar display turned on.



Word Wrap Message Display - No
Select this button if you want messages displayed exactly as they are posted on DELPHI.



Word Wrap Message Display - Yes
Select this button if you want messages automatically formatted to fit the window width.



Word Wrap Message Editor - No
Select this button if you do not want a line to wrap until you press <CR> when you are editing 
messages.



Word Wrap Message Editor - Yes
Select this button if you want lines to automatically wrap when you are editing messages.

NOTE:    This is the recommended setting.



Transmitted Message Width
Enter the number that represents the maximum length each line should be when the message is posted 
on DELPHI.    The recommended setting is between 65 and 70.

NOTE:    This setting does not determine the width of the window you are entering text in.    As you are 
typing your message, it may not be this width; however, the message will be formatted to this width 
when it is sent to DELPHI.



The Editor Macros are used to include signature and tag lines in the messages you compose.



Signature Line 1 (.s1)
Enter the line of text you want to sign messages with, or enter @filename to use a signature file.    If you 
use a file, the InterNav directory will be assumed unless the full path specification is included.
To manually include this signature in a message, enter .s1 on the line you want the signature to appear.  
To automatically include this signature in a message, choose Signature Line 1 in the Auto Signature 
field of this dialog box.



Signature Line 2 (.s2)
Enter the line of text you want to sign messages with, or enter @filename to use a signature file.    If you 
use a file, the InterNav directory will be assumed unless the full path specification is included.
To manually include this signature in a message, enter .s2 on the line you want the signature to appear.  
To automatically include this signature in a message, choose Signature Line 2 in the Auto Signature 
field of this dialog box.



Tag Line 1 (.t1)
Enter the text and any macros you wish to include when commenting to a message.    To manually 
include this tag line in a message, enter .t1 on the line you want the tag to appear.    To automatically 
include this tag line in a message, choose Tag Line 1 in the Auto Tag Line field of this dialog box.



Tag Line 2 (.t2)
Enter the text and any macros you wish to include when commenting to a message..    To manually 
include this tag line in a message, enter .t2 on the line you want the tag to appear.    To automatically 
include this tag line in a message, choose Tag Line 2 in the Auto Tag Line field of this dialog box.



Macro Brackets
Enter the characters you wish to use to designate a macro.



End of Message Tag
Enter the text you want displayed in the window when the end of a message is reached.



Auto Signature Line

Click on the  to open the list box and select your preference for automatically adding a signature line 
to messages you compose.

None will not place a signature line on messages.
Signature Line 1 will automatically place the text contained in the Signature Line 1 field in the edit 
window when it is opened.
Signature Line 2 will automatically place the text contained in the Signature Line 2 field in the edit 
window when it is opened.



Auto Tag Line

Click on the  to open the list box and select your preference for a tag line.

None will not insert a tag line when you are replying to a message.
Tag Line 1 will use the format specified in the Tag Line 1 field.
Tag Line 2 will use the format specified in the Tag Line 2 field.



Quoting String
Enter the character, or string of characters, you want placed in front of text that has been Paste Quoted 
into the message you have composed.    Many people use the '>' character to signify the text in their 
message has been quoted from another message.



Assign Accelerator is used to add a hot key combination to a command.    Just press the key 
combination you wish to use, and then choose OK.



Menu Item
This area will display the command name you are assigning an accelerator key to.



Accelerator Key
Press the key combination you wish to assign to the command.



Profile is used to change the profile (configuration) used for the session, or to create and remove 
profiles.    The profile you select will be used until you use this command to change it again.
To create a new profile, type a name in the Profiles field and then choose OK.    The new profile will 
assume the options (setup parameters) that were loaded at the time it was created.    If you need to 
change any of the parameters for the new profile, use the Options menu to access the various settings.

NOTE:    The name of the profile that is being used will appear in the title bar of the InterNav window.



Delete

This button will remove the selected entry from the list.



Profiles

Click on the  to open the list box and select the profile to be used.    Or, to create a new profile, type 
the new name in this field.



The ComEngine Settings are variables that determine how the communication engine operates.



Flush Character
This is a special character which tells DELPHI to discard any characters it may have in its input buffer.    
DELPHI uses a ^X (ASCII 24) as this special character.
NOTE:    The only time you should need to change this is if DELPHI should change it.



Flush Commands - No
This tells the communication engine not to flush DELPHI's input buffer before it sends commands to 
DELPHI.



Flush Commands - Yes
This tells the communication engine to flush DELPHI's input buffer before it sends commands to 
DELPHI.    It does this by sending the Flush Character to DELPHI before it sends the commands.
NOTE:    The only time you should have to enable this command is if you have a noisy line.



Monitor Noise - No
This tells the communication engine not to monitor its input buffer for noise.



Monitor Noise - Yes
This tells the communication engine to monitor its input buffer for noise.    If noise is detected, the 
communication engine will clear its input buffer and send a Flush Character to clear DELPHI's buffer.

NOTE:    The only time you should have to enable this command is if you have a noisy line.



Ignore Carrier - No
Use this variable to tell the communication engine to use the carrier detect signal.



Ignore Carrier - Yes
The communication engine defaults to ignoring your modem's carrier detect signal to determine whether 
or not you are on-line.

NOTE:    It is much more efficient to set up your hardware to pass the proper modem signals and not to 
ignore the carrier detect signal.



Carrier Loss Delay
This variable tells the communication engine to wait for the "Carrier Loss Delay" number of milliseconds 
before reacting to the loss of the carrier.
NOTE:    Some modems toggle the carrier detect line once a connection has been established.    The 
symptom of this action is that your logon script will fail soon after a modem connection has been 
established.    If you are experiencing this problem, try setting this variable to 500 (.5 seconds).    If 500 
does not work, try going as high as 1500.    If you still have problems at 1500, use the Ignore Carrier 
variable.



End of Line Delay
This variable controls the pacing of lines of text transmitted to DELPHI.    The minimum amount of pacing
should 125 (.125 seconds).    Do not set this variable less than 125.    If you are overflowing DELPHI with
text files increase this number until the problem goes away.
NOTE:    About the only time this variable will need to be changed is when you are communicating with 
DELPHI at speeds of 9600 bps or greater.



Raise DTR/RTS - No
This tells the communication engine to not use the Data Terminal Ready and Request To Send signals.



Raise DTR/RTS - Yes
This tells the communication engine to use the Data Terminal Ready and Request To Send signals.



Transmit Flow Control

Click on the  to open the list box and select the flow control to use when sending data.    The choices 
are:

None, Xon/Xoff, Clear To Send, Data Set Ready, CTS+Xon/Xoff, DSR+Xon/Xoff

NOTE:    Consult your modem user guide to determine the flow control it supports.



Receive Flow Control

Click on the  to open the list box and select the flow control to use when receiving data.    The choices
are:

None, Xon/Xoff, Request To Send, Data Terminal Ready, RTS+Xon/Xoff, DTR+Xon/Xoff

NOTE:    Consult your modem user guide to determine the flow control it supports.



Forward is used to send an E-mail message to another address.    Enter the address of the person you 
wish to send the message to, and then choose OK.



Use this area to enter the address(es).    Multiple addresses are entered by separating each with a 
comma.    For example:

address1,address2,address3



Address Book
Opens the E-mail Address Book to select an address for the message.



The E-mail Address Book is used to keep a list of the addresses (DELPHI usernames and Internet 
addresses) of people you send mail to.
To add an address to the message you are sending, select the entry, and choose OK.    To pick multiple 
addresses, just hold down the control key while you are selecting the address.    Use the scroll bars to 
display entries not currently visible in the list box.
To add a new address to the list, enter the DELPHI username or Internet address in the UserName field.
Next, Tab to the Comment field to make any notes you want about the address, and then choose Add 
to insert the new address in the list.

NOTE:    If you have a selection made in the terminal window and then open the E-mail Address Book, 
the selection will be assumed to be an address and will be used to fill in the "UserName:" field.

To edit the information for an address, select the entry, make any corrections, and then choose Change. 
When you exit the dialog box, you will be prompted to save the changes.



Addresses
The list of usernames will be displayed in this area.



UserName
Enter the username of the person you wish to add to the list in this area.



Comment
Enter any notes for your use in this area.



Insert
Inserts the removed (deleted) item at the current cursor location.



Add
This button will insert the new entry in the list.



Change
This button will change (edit) the information for the selected entry.



The Go To dialog box is used to quickly change to your favorite locations on DELPHI.    To pick a 
location, select the entry, and then choose OK.    Use the scroll bars to display entries not currently 
visible in the list box.
To add a new entry, enter the full menu name, or the abbreviations, in the Command field.    If the 
location is on a sub-menu, just include all the menu names on the same line.    In the Description field, 
enter the name of menu,or a description you prefer.    The text placed in the description field will be 
displayed as the entry in the list.    After you enter the data for these fields, choose Add, and the new 
entry will be added above the current selected position.
To edit the data contained in an entry, select the entry you want to change.    Then Tab to the Command 
and Description fields to edit the text as needed.    When you are done making the modifications, 
choose Change.
To remove an entry from the list, select the entry, and then choose Delete.
To change the position of an entry in the list, click on Move Up to move the entry up one line at a time, 
or click on Move Down to move the entry down one line at a time.

NOTE:    If you have made any changes to the list of entries, such as moving or adding, you will be 
prompted to save the changes when exiting the dialog box.



Move Down
Moves the selected entry down one line.



Move Up
Moves the selected entry up one line.



Description
Enter the description you want displayed for the command in the list.    If no description is entered, the 
command will be displayed.



Command
Enter the menu names or abbreviations needed to execute the command.



This area displays the list favorite locations.



The Color Preference dialog box is used to set the colors used by InterNav.

Click on the various  to open the list box and select the colors used for VT100 terminal attributes.



Display Background (Workspace)

Click on the  to open the list box and select the color used for the Display Background.



Screen Foreground

Click on the  to open the list box and select the color used for the VT100 Screen Foreground.



Screen Background

Click on the  to open the list box and select the color used for the VT100 Screen Background.



Blink Foreground

Click on the  to open the list box and select the color used for the VT100 Blink Foreground.



Blink Background

Click on the  to open the list box and select the color used for the VT100 Blink Background.



Bold Foreground

Click on the  to open the list box and select the color used for the VT100 Bold Foreground.



Bold Background

Click on the  to open the list box and select the color used for the VT100 Bold Background.



Underscore Foreground

Click on the  to open the list box and select the color used for the VT100 Underscore Foreground.



Underscore Background

Click on the  to open the list box and select the color used for the VT100 Underscore Background.



Reverse Foreground

Click on the  to open the list box and select the color used for the VT100 Reverse Foreground.



Reverse Background

Click on the  to open the list box and select the color used for the VT100 Reverse Background.



File Transfer is used to upload or download a file from DELPHI.    Select the option button to either send 
or receive, the protocol to use, and then select OK.



Receive
If you are downloading a file from DELPHI, select this option.



Send
If you are uploading a file to DELPHI, select this option.



File Transfer Protocol

Click on the  to open the list box and select the protocol to use.    The choices are: Zmodem, 
Xmodem1K, and Xmodem.



Entering and Exiting E-mail

Everyone on DELPHI can send and receive private electronic mail to DELPHI members, and users on 
the Internet.    To enter the E-mail System, click on the Mail button or choose Mail from the View menu, 
and the Mail tool bar will be displayed.

NOTE:    There are locations on DELPHI where the Mail command will not work, such as More? prompts 
and in DELPHI Conference areas.

If you have new E-mail, a list of the new messages will be displayed automatically in the Folders 
window.    If you do not have new messages, a list of your previously read messages will be displayed.
To exit the E-mail system, click on the Go Back button .

NOTE:    You may also enter the DELPHI e-mail system by typing the word "Mail" wherever it appears on
a DELPHI menu.    However, you will not be able to use InterNav's graphical e-mail features and editing 
windows when you enter mail in this way.    On the other hand, DELPHI's mail system supports some 
advanced text commands not supported by InterNav's current graphical mail system.    To find out how to
use these commands to execute operations such as sending and receiving binary files, please refer to 
DELPHI: The Official Guide, which is available for purchasing on-line from the Using DELPHI menu.



Reading Messages

Your mail messages are listed in the Folders window.    If the Folders window is not currently open, click 
on the View Folders button or choose View Folders from the Mail menu.

NOTE:    If you receive a notification that you have new mail while you are in the mail system, you must 
do a Folders command in order to generate an updated list that will include the new mail.

To read a message, click on the line that contains the message in order to select it, and then click on the
Read button in the Folders window, or press Alt+R.    Also, you can double click with the left mouse 
button anywhere on the line containing the message you want to read.
The message will be displayed in a From window with the author's name shown in the title bar.    Use the
scroll bar to display any text not currently visible in the window.
When you are finished with the memo, click on the Close button, or press Alt+C.    You will then be 
prompted to delete the message.    If you no longer need the message, answer Yes.    If you want to keep
the message for later reference, answer No to leave it in your MAIL list.



Forwarding Messages

To forward (reroute) a mail message to another user, you must first have the message displayed in a 
From window.    Next, click on the Forward button, or press Alt+F, and the Forward dialog box will 
open.    Either type the user name, or click on the Address Book button to select a name, and then 
choose OK.
For information on how to display a mail message, see Reading Messages.



Replying to Messages

To reply to a message, you must have the message displayed in a From window.    Next, click on the 
Reply button, or press Alt+R, and the Reply window will open.    The To and Subject fields of the 
memo will be filled in automatically and can not be edited since this is a reply.    You can, however, add 
recipients to the CC field.
When you finish composing your reply, click on the Send button, or press Alt+S to transmit the 
message to DELPHI.
To abort the reply, click on the Close button, or press Alt+C.
For information on how to display a mail message, see Reading Messages.
For additional information on using edit windows, see the Editing in InterNav topics.



DELPHI Storage Limitations

You may store e-mail messages and other files on-line on DELPHI's computers for limited periods of 
time.    Your e-mail folders and personal workspace are automatically managed by a program that 
deletes your older messages and files.    E-mail messages that you have not yet read will remain on-line 
for a minimum of 30 days from the date on which the message was sent.    Messages that you have 
read, but have not yet deleted will remain on-line for a minimum of 7 days from the date sent.    Files in 
you personal workspace will be allowed to remain on-line a minimum of 48 hours.    You are responsible 
for saving messages to your local disks, and downloading files in your workspace within the allotted time
periods.
For additional information, see Saving Messages.



Deleting Messages

To delete (remove) a previously read message, open the Folders window by clicking on the View Folders
button, or selecting View Folders from the Mail menu.    Next, select MAIL from the drop down list box in
the Folders window to display the list of messages.    Click on the entry line of the message your want 
deleted in order to select it, and then click on the Delete button in the Folders window, or press Alt+D.   
You will then be prompted to confirm the deletion.    If you select Yes at the prompt, the entry line for that 
message will be changed to "Deleted".

NOTE:    Once a message has been deleted, it can be displayed again during the same mail session.    
Just use the Folders command again to update the mail lists, and select WASTEBASKET from the drop 
down list box.



Sending Messages

To send a mail message, click on the Send New Mail button or choose New Message from the Mail 
menu, and the Send window will open.    First type the e-mail address in the To field, or click on the 
Address button to choose one or more addresses contained in the E-mail Address Book.    To enter 
multiple addresses, separate each with a comma.    For example: 

To:    address1,address2,address3,address4
After entering the address(es), press the Tab key to move to the next field.    Continue with this process 
to enter information in the Subject and CC fields, if applicable.
When you finish composing your message, click on the Send button in the window, or press Alt+S to 
transmit the message to DELPHI.
To abort the command, click on the Close button, or press Alt+C.

NOTE:    To send e-mail to DELPHI members, enter their DELPHI username in the To field of the Send 
window.    To send e-mail to people on the Internet, enter their Internet adrress in the To field of the Send 
window.    Internet addresses are typically formatted like this:

president@whitehouse.gov

You must be registered for Internet access before you can send Internet e-mail.

For additional information on using edit windows, see the Editing in InterNav topics.



Saving Messages

To save a mail message to disk, you must first have the message displayed in a From window.    Next, 
choose either Save As or Export Text from the File Menu.    The Export Text command will append the 
message    to an existing file.    The Save As command writes a new file.
For information on how to display a mail message, see Reading Messages .



Adding Names to the Address Book

InterNav provides an E-mail Address Book to store the addresses (DELPHI usernames and Internet 
addresses) of the people you send messages to..    There are several ways that addressses can easily 
be added to the address book.
If you are reading an e-mail message and want to add this address to the address book, click on the 
Address button in the From window.    The E-mail Address Book will open with the address that is listed
in the From field of the message already entered in the UserName field of the dialog box.    If you wish to
add a description for your use, tab to the Comment field, and enter the text.    Next, click on Add, and 
the address will be added to the bottom of the list.    When you are ready to close the dialog box, click on
OK.    You will then be prompted to save the changes.    Answer yes to save the addition you have just 
made.
When you are sending or replying to an e-mail message, this address can also be added to the address 
book.    Click on the Address button in either the Send or Reply window, and the E-mail Address Book 
will open with the address that is listed in the To field entered in the UserName field of the dialog box.    
When you are ready to close the dialog box, click on Cancel, and you will then be prompted to save the 
changes.    Answer yes to save the addition you have just made.
NOTE:    If you click on OK, the address that is selected in the dialog box will be added to the To field of 
your message.
To add an address that it is displayed in the Terminal window, select the text with a mouse, and then 
click on the Addresses button.    The selected text will be entered in the UserName field when the E-mail
Address Book opens.    When you are ready to close the dialog box, click on OK, and you will be 
prompted to save the changes.
The address book can also be opened at any time (off-line or on-line) by choosing Address Book from 
the File menu.    If you want to add an address from a source that has not been discussed, you can 
Copy (Ctrl+C or Ctrl+Ins) the text, and then Paste (Ctrl+V or Shift+Ins) it in the UserName field of the
dialog box, or    just type the address in that field.    When you are ready to close the dialog box, click on 
OK, and you will be prompted to save the changes.



DELPHI Account Registration

Before you can log on to DELPHI, you must first register.    If you are already registered as a DELPHI 
member, and you have a username and password, you may log on to DELPHI by clicking on the Logon 
button, or by choosing Log On Auto from the Connection menu.
To register your DELPHI account, first make sure your modem is turned on, and is connected to a 
standard telephone line.    Click on the Register button, or choose Register from the Connection menu.   
At the next window, click on Continue.    This will automatically dial DELPHI's toll-free registration 
number.
Once connected, you will see information about trial offers and rates for using DELPHI.    Answer the 
questions and fill in the information that is requested.    When registration is complete, you will be 
automatically disconnected and returned to the Off-line tool bar.    If you would like to review any of the 
information that was displayed during registration, the entire process is automatically saved for your 
reference in a file called REGISTER.TXT.    To view the file, you can open it from within InterNav by 
clicking on File, then selecting Open.    The file will be found in the InterNav directory.    You can also use 
Windows' Notepad, or any word processor to view the file.
If you have the necessary information, you can start using your new DELPHI account right away.    When
you register using InterNav, your username, temporary password, and local access number, are 
automatically loaded into InterNav's default settings.    To connect to DELPHI, you only need to click on 
the Logon button.
The first time you log on to DELPHI, you will be required to change your password to ensure the security
and privacy of    your account.    Your password setting in InterNav will be updated automatically.    If you 
prefer to enter your password manually each time you log in, select Options from the Off-line tool bar, 
then select User, and delete the information stored in the Password and Verification fields of the User 
Information dialog box.



InterNav Basics

InterNav uses two executable programs to log onto and communicate with the DELPHI service:    
INTERNAV.EXE and JLCOMENG.EXE.    INTERNAV.EXE is the front-end portion of the program, and 
JLCOMENG.EXE is the communication engine, which handles the modem communication tasks.    
While on-line to DELPHI, both programs will be running simultaneously.    JLCOMENG.EXE runs in the 
background, and you will see its icon minimized on your desktop while it is running.    Should an error 
occur that causes INTERNAV.EXE to close, but JLCOMENG.EXE remains open, you can close it 
manually by selecting the icon with your mouse and using Alt+F4 to close it, or through the Control 
Menu's "Switch To..." command.
Commands are issued by clicking on a button located on the tool bar, or choosing a selection from the 
menu bar.    In some instances after a selection has been made, the menu bar and/or tool bar will 
change to reflect another set of commands for you to choose from.
If you are not active in InterNav for a period of ten minutes, the status bar will display "Logging off in 30 
seconds" with a countdown proceeding.    To stop the automatic log off, execute any command, press 
Escape, or move the mouse.    If you do not respond within the 30 seconds, you will be logged off of 
DELPHI automatically.

NOTE: Ten minutes is the default timeout period, which can be changed on-line from the Settings menu, 
under Using DELPHI.

All data (received and transmitted) will be displayed in MDI (document) windows.    InterNav uses 
several MDI windows depending on the data type.    Commands that are specific to a MDI window are 
listed under the Current menu.
The majority of the time you will be interfacing with DELPHI using the Terminal window.    When you are 
in the Terminal window, most all navigation can be done using the mouse if you prefer.    For further 
information on using a mouse, see Navigating DELPHI Menus.    As you are using DELPHI, you may 
find information that you want to save or use in other applications.    For information on this, see 
Copying Text and Capturing Text.



Using Help

The InterNav help system offers several ways of finding the information you need.    The full help system 
can be accessed, or just the help topic for a specific command, menu, dialog box, window, or tool bar.

NOTE: The InterNav Help system contains information on InterNav commands only; it does not contain 
information about DELPHI commands and services.    If you need help using the DELPHI service, either 
double click on the word 'Help' if it appears on a menu or type help at any DELPHI prompt while you are 
on-line.    Free assistance with the DELPHI service and InterNav is available in the Member Services 
Forum (See InterNav's Go To list), and by telephone (see the Product Support topic).

Help Menu

The Contents command will open the help system with the InterNav Help Table of Contents displayed.   
The contents lists the procedural topics (how to's), followed by the commands, and tool bars.
The Search for Help On command will call up the help system in Search mode.    You can also initiate a
search by first marking a string of text, such as a command name in a script, before choosing the 
Search command, and then if a help topic exists that matches the search string, the topic will be 
displayed automatically.

Context Sensitive Help

Context sensitive help differs from using regular help because the topics are displayed in a secondary 
window, rather than executing the full help system.    To get context sensitive help for a menu command, 
or field in a dialog box, just move to the command, or field, and press F1.    To get context sensitive help 
for a tool bar button, hold the shift key down while clicking on the button.

Dialog Box Help

When you select the Help button in a dialog box, the help topic for that dialog box will be displayed.    
The help topic will consist of the dialog box and a description of the use of the various fields.    To see the
help for a field, move the mouse over the field and click on the left mouse button, or Tab to the field, and 
press Enter.    A pop up window will then open with the help information for that field.

Window Help

When you select the Help button in a window, the help topic for that window will be displayed.

Tool Bar Help

When you select the Help button on a tool bar, the help topic for that tool bar will be displayed.    To see 
help for a button, move the mouse over the button and click on the left mouse button, or Tab to the 
button and press Enter.    When you select a button, a pop up window will open with the description of 
the command.    If the command opens a dialog box, a jump to the dialog box will be listed.    If the 
command results in a new tool bar being displayed, a jump to the tool bar will be listed.



Product Support

If you should need further assistance using InterNav or DELPHI, free help is available on-line and by 
telephone.
You can receive on-line help with InterNav on DELPHI by selecting the InterNav Support Forum using 
the Go To command, or by typing Go Using InterNav at any DELPHI prompt.    You can also send e-mail 
to the DELPHI Member Services Department (username:SERVICE), which is the first entry in InterNav's
E-mail Address Book.
If you prefer to talk with a representative, call 1-800-695-4005, or 617-491-3393 outside the US.



Connecting To DELPHI

Once you are a DELPHI member, you may connect (log on) to DELPHI by clicking on the Logon button, 
or by choosing Log On Auto from the Connection menu.    If you need to stop the logon process, click 
on the Stop/Cancel button, or press Control+Break.
The first time you use InterNav to log on to DELPHI, one of two things can happen when you click on the
Logon button, depending on how you registered your account.    If you used InterNav to register, you will 
be logged on automatically.    If, on the other hand, you have an account on DELPHI that you did not use
InterNav to establish, you will see the User Info dialog box displayed.    Enter your DELPHI Username in 
the Username field, and enter your password in the Password and Verification fields if desired (see 
note below).    Next, you will see the Scripts Settings dialog box displayed.    Select the Access Method 
(SprintNet, Tymnet, or Direct) that you currently use to access DELPHI, and enter the phone number 
into the Access Number field.    Click on the Logon button again to resume logging on to DELPHI.
When you are on-line, the Main window will be displayed.    The Announcements window will open if 
there is a news banner from DELPHI, or if you have new mail.
For information on using multiple access numbers, such as Tymnet and Sprintnet, see Creating InterNav
Profiles.

NOTE:    Automatic password entry is optional.    If you prefer to be prompted for your password each 
time you log on, you may leave the password and verification fields found in User Info under the 
Options menu blank.



Moving Around Quickly with Go To

The Go To command is used to quickly change to your favorite locations without having to navigate the 
menu system.    To pick a location, click on the Go To button, or choose Go To from the View menu, and 
the Go     To   dialog box will open displaying a list of the locations.    To change to a location, select it by 
clicking on that entry in the list, and then choose OK.    You can also just double click on the entry to 
change locations.    If there are more entries in the list than are currently visible, use the scroll bar to 
view the entire list.

NOTE:    There are locations where the Go To command will not work, such as More? prompts, Usenet 
readers, Gopher menus, and Newswire services.



Posting Messages On-line

InterNav provides the Edit Posting window to use when composing messages.    The window will 
automatically open when DELPHI is ready to receive a message.    When you finish composing the 
message, click on the Send button or press Alt+S, to transmit the message.    If at any point you want 
to abort (cancel) the message, simply click on the Close button or press Alt+C.
For additional information on using edit windows, see the Editing in InterNav topics.

Forum Messages

To post a forum message, double click with the left mouse button on the word "Add" at the Forum 
prompt.    You will then be prompted by DELPHI with "To:".    Click once on the right mouse button to 
accept the default of "All".    If you want the message directed to a specific person, just enter the 
username in place of All.    Next enter the subject of the message, and then you will be prompted for the 
Topic.    To choose a topic, click on the right mouse button at the prompt, and a list of all the topics will be
displayed.    Next, just double click with the left mouse button on the first word of the topic name.    The 
Edit Posting window will then open to compose your message.

NOTE:    If you want to view the terminal window while the edit window is open, choose Tile Horizontal 
from the Window menu.

To reply to a forum message you have just read, double click with the left mouse button on the word 
"Reply" at the Forum prompt.    You will then be prompted with "To:".    Simply click on the right mouse 
button to accept the default username, or enter a username if you want the message directed to a 
different person.    The Edit Posting window will then open to compose your reply.

Usenet Messages

The Edit Posting window also opens automatically when you post or reply to Usenet messages as well. 
This feature only works through DELPHI's Usenet reader, which can be found on the Internet Services
Menu, as well as many other menus throughout DELPHI.



File Transfers

To do a file transfer, you must first set up DELPHI to get ready to transfer the file.    If you need help with 
setting up DELPHI, double click on the word help at the database or workspace prompt.
To set up InterNav, choose File Transfer from the File menu and the Transfer File dialog box will open.   
Select the file protocol to use, whether you are receiving or sending the file, and then click on OK.
NOTE:    InterNav does support transferring files in the background.    Just click on the minimize button if 
you prefer to use other applications while a transfer is in progress.



Conferencing on DELPHI

You can chat real time with other users on DELPHI using the Conference area.    There is a Main 
conference area, and most SIG and Custom Forums also have conference areas.
To enter a conference area double click with the left mouse button on the word Conference at the Main 
menu, a SIG menu, or the Custom Forum menu of the area you want to enter.    To get a list of the 
various commands to use in the conference area, type help and press the Enter key.    To open 
InterNav's chat buffer to type your messages in, choose Chat Mode from the Current menu.

NOTE:    You can also use Chat Mode for Internet Relay Chat (IRC).



Navigating DELPHI Menus

Using the Mouse

The InterNav Terminal window provides a mouse interface to the DELPHI menu system.    To navigate 
the menus, double click with the left mouse button on the first word in the menu item.    To select an item 
from a numbered menu, such as a Gopher menu or a Newswire listing, just double click on the number.  
If you need to back up a menu, double click on the word 'exit', or press Ctrl+Z.    To stop the process of a 
command, press Ctrl+C.    To quickly return to the DELPHI main menu, click on the Go Main button.

NOTE:    There are locations where the Go Main command will not work, such as More? prompts, 
Usenet readers, Gopher menus, and Newswire services.

To pick a selection at a prompt, double click on the word, or click on the right mouse button to issue a 
carriage return.
If you need help using DELPHI, either double click on the word 'help' or type help at any DELPHI 
prompt.

Using the Keyboard

The Terminal window is a VT100 emulator and keystrokes are transmitted just as they would be using a 
terminal.    To navigate the menus, type the first three letters of the menu choice and press Enter.    To 
select an item from a numbered menu, such as a Gopher menu or a Newswire listing, type the number 
and press Enter.    If you need to back up a menu, press Ctrl+Z.    To stop the process of a command, 
press Ctrl+C.
If you need help using DELPHI, type help at any DELPHI prompt.

NOTE:    For further information on changing locations, see Moving Around Quickly with Go To.



Disconnecting from DELPHI

To disconnect from (log off of) DELPHI, click on the Logoff button, or choose Log Off from the 
Connection Menu.    To exit the InterNav program after logging off of DELPHI, click on the Exit button, or 
select Close from the File Menu.



Capturing Text

InterNav does not automatically buffer all data transmitted from DELPHI.
If you wish to capture data as it is displayed in the terminal window, open a capture file by choosing 
Capture from the File menu.    You will be prompted for a file name.
To close the capture file, just do another Capture command.    You will then be prompted to close the 
file, and whether you want to start a new file.



InterNav and the Internet

With DELPHI and InterNav, communicate with the more than 20 million people who are connected to the
Internet, and access any available information or services.
DELPHI offers full Internet access, as well as useful menus which organize much of the content and 
services of the Internet, and plenty of resources to help you get to where you want to go.    InterNav has 
some features that will help you to make better use the Internet, and combined with DELPHI's menus 
and resources, you'll be able to connect with people and places around the world without being 
frustrated by technical obstacles.



Registering for Access

Full Internet access is available to any DELPHI member for a small monthly fee.    To register for access,
click on the GoTo button while on-line, and select "Register for Internet Access", or select "Register" 
from the Internet Services Menu.    Registration gives you access to all of DELPHI's Internet 
resources immediately.



Internet E-Mail

Sending Internet E-mail with InterNav is as easy as sending mail to other DELPHI members.    InterNav 
handles the special formatting required by DELPHI for you, whether you are entering addresses into the 
Address Book, or directly into the To field of a message.
See also Sending Messages.



Gopher Menus

Probably the easiest way to get started using Internet services is through a menu system called Gopher. 
DELPHI has a large Gopher menu system available from the Internet Services Menu, which 
organizes services and information on the Internet by subject matter.    In addition, there are smaller, 
more specialized Gopher menus within many DELPHI Special Interest Groups, Custom Forums, and 
other areas of DELPHI.
Gopher menus are numbered menus, which means that every item description is preceded by a 
number.    InterNav lets you click your way through Gopher menus with your mouse.    Just double-click 
on the number of your choice to select it, or click the right mouse button to select default actions or to 
display more of a menu or text information.
See also Navigating DELPHI Menus.
Gopher menu items can lead to various types of information and services.    What kind of response you 
can expect from each item is indicated by a word in the right hand column, on the same line as the item 
description.
The word "Menu" indicates that selecting the item will lead to another Gopher menu.
"Text" indicates that selecting the item will display text information.
"Telnet" indicates that selecting the item will actually connect you to a remote computer.
Other menu items are designated by words that describe a file type such as Image, PC-DOS, BinHex, 
etc.    These items use FTP to transfer a file to your PC.    Retrieving files through DELPHI's Gopher 
using InterNav is much easier than standard FTP file transfers.    After you've selected an item, you will 
be prompted to select a download protocol.    Just select ZModem, and InterNav will receive the file 
automatically.    When the transfer is complete, you will be returned to the Gopher menu.



Usenet Discussion Groups

One of the most powerful and popular communication services on the Internet is called Usenet.    Usenet
is a collection of thousands of electronic "bulletin boards", similar to DELPHI's Forums.    Usenet 
"Newsgroups" (as they are traditionally called) reach over 2 million people from all around the globe.    
DELPHI has its own Usenet reader which places selected Usenet groups into numbered menus similar 
to Gopher, which can be navigated with InterNav by double-clicking on the number of any item.
Specialized topical Usenet menus can be found on the Internet Services Menu, as well as in many 
Special Interest Groups and Custom Forums.
InterNav automatically opens an Edit Posting window when you are posting a new message, or replying 
to an existing message, which includes standard Windows edit controls as well as customized editing 
controls such as Import Text and Paste Quoted.
For additional information on using edit windows, see the Editing in InterNav topics.



Telnet

Telnet is a standard Internet method for connecting to remote computers and services.    InterNav's 
Terminal window supports VT-100 emulation, which is also supported by most Internet Telnet sites.    For 
best results, it is strongly recommended that you issue the command /ECHO=HOST before starting a 
Telnet session, whether you are starting from the Telnet prompt on the Internet Services Menu or a 
Gopher Menu.    Host-echo mode causes a delay to occur between the time a keystroke is entered and 
the appearance of the character on the screen.    While this may be annoying or confusing at first, it does
make your Telnet sessions more reliable and productive.    If you would like to switch back to regular 
echo mode after your Telnet session, use the command /ECHO=ECHO.

NOTE: If you are logging in via Tymnet, you should be in Host-echo mode by default, and there is no 
need to issue any commands before or after a Telnet session.

When you start a Telnet session, InterNav will replace the On-line tool bar with new tool bar which 
consists of a Go Back button and a help button.    Use Go Back to return to DELPHI quickly.



FTP

File Transfer Protocol (FTP) is a standard Internet method for transferring files from remote sites.    Many
Gopher Menus use FTP to transfer files from computers on the Internet to your PC in one step.    If you 
know the address of a site from which you want to retrieve files, you can select FTP from the Internet 
Services Menu to connect and transfer files to your personal workspace on DELPHI.    Once 
transferred, you must go to your workspace to download the files to your PC.



Internet Relay Chat (IRC)

Internet Relay Chat is a popular real-time conferencing system on the Internet.    Since DELPHI uses 
Telnet to connect to IRC, it is strongly recommended that you issue the command /ECHO=HOST before
selecting IRC from the Internet Services Menu.    Host-echo mode causes a delay to occur between 
the time a keystroke is entered and the appearance of the character on the screen.    While this may be 
annoying or confusing at first, it does make your IRC sessions more reliable and enjoyable.    If you 
would like to switch back to regular echo mode after your IRC session, use the command 
/ECHO=ECHO.

NOTE: If you are logging in via Tymnet, you should be in Host-echo mode by default, and there is no 
need to issue any commands before or after an IRC session.

When you start an IRC session, InterNav will replace the On-line tool bar with new tool bar which 
consists of a Go Back button and a help button.    Use Go Back to return to DELPHI quickly.
Once you are connected to IRC, you may select Chat Mode from the Current pull-down menu to 
activate a two-line buffer at the bottom of the Terminal window, which allows you to type in your 
messages outside of the Terminal window.



The Internet Services Menu

All the major Internet tools and resources are accessible through the Internet Services Menu, which can 
be selected from DELPHI's Main Menu, or by clicking on the Internet button.    Specialized Gopher 
Menus and Usenet Menus can be found within Special Interest Groups and Custom Forums as well.



Creating InterNav Profiles

When you install InterNav, a profile by the name of Default is created automatically with the data you 
enter in the various configuration settings on the Options menu.    If you use various phone numbers or 
methods to access the network, a separate profile can be created for each one making it a simple matter
to change the settings used in a session.
To create a new profile, choose Profile from the File menu, and the Profile dialog box will open.    Enter 
a new name in the Profiles field, and then select OK.    You will be prompted to confirm the new profile, 
and it will then be loaded.
The new profile will assume the settings that were used in the previously loaded profile.    You now need 
to change the configuration settings on the Options menu that will be different in this profile.    If this 
profile was created to change access methods, such as logging on to DELPHI direct, the information 
you need to change will be in the Phone Number settings.
To change the profile used by InterNav, select the name from the Profiles field, and press OK.    The 
profile selected will be used until you change it again.
NOTE:    A profile name can be included as part of the command line.    If you include a profile name, 
InterNav will select that profile and execute an automatic log on upon start up.    Use the Program 
Manager's File Properties command to modify the command line, such as, c:\internav\internav.exe 
default.



Adding Locations in Go To

You can add your own favorite places within DELPHI to the GoTo list so that you can go directly there 
quickly from almost anywhere else.    First, you need to find out the sequence of commands you would 
use to get there from DELPHI's Main Menu.    Then, click on the Go To button, or choose Go To from the
View menu to open the Go     To   dialog box, and type the commands into the Command field, separated 
by spaces.    Type a description of the location into the Description field, and click on Add to add it to 
your list.
Example:
Let's say you frequently check news about the US economy on the Reuters Newswire.    To get to that 
service from the Main Menu, you first select News, Weather, and Sports, which you can select by typing 
NEWS.    From the next menu, you would select US News, or type US.    On the US News menu, you 
would select Economy.    The whole sequence of commands should be entered into the Command field 
of the Go     To   dialog box, which in this case would be:

NEWS US ECONOMY
In the Description field you can type something you can understand, like US Economic News.    Then 
click on Add, and the item is added to your GoTo list.
The next time you want to check that newswire, you only need to click the Go To button and double click 
on the "US Economic News" to go directly there from almost any other place on DELPHI.

NOTE:    The GoTo feature can be programmed to go to services and menus within DELPHI only.    While
GoTo can take you to and select Internet resources from DELPHI's menus, it cannot be used to navigate
services hosted by remote computers on the Internet.



Assigning Accelerator Keys

Your choice of accelerator keys can be assigned to any command.    To add an accelerator key, select 
the command and then press F2.    The Accelerator dialog box will open, and prompt you for the key 
combination to use for this command.
To remove an accelerator key, follow the same procedure as for assigning a key, except press F3 
instead of F2.
For example, let's assume you want to make the key combination of Ctrl+X logoff DELPHI.    You would 
first press Alt+C to open the Connection menu, and then press the Down Arrow three times to move 
the selection bar to the command named Logoff.    Next, press F2 to open the Accelerator dialog box, 
and then press Ctrl+X to assign the key combination.    To save the setting, choose OK.

NOTE:    If the key combination you pick is already in use by another command, you will be informed that
it is already assigned.    To use this key combination, you will need to remove it from the other command,
and then assign it again. 



Copying Text

While you are using InterNav on DELPHI, you can copy text from the various windows to do such things 
as inserting it another application or a message you are composing.    InterNav uses the standard 
Windows Copy command in conjunction with the Clipboard.    However, copying text from the Terminal 
window does require a special method.
To copy text from the Terminal window, first select the text using the mouse.    You can not use the Shift 
key in combination with arrow keys because these keystrokes would be transmitted to DELPHI rather 
than selecting text.    After selecting the text, choose Copy from the Edit menu.    You must choose the 
Copy command as opposed to using accelerator keys because these keystrokes would be transmitted 
to DELPHI rather than doing the copy.



Using Edit Windows

When you are composing a message in an InterNav edit window, you are working in a standard 
Windows edit control.    To enter text in the edit window, you can type it, paste it from the Clipboard, or 
import a text file.    The edit window can hold approximately 32,000 characters.
To paste text in your message, you must first Copy the text to the Clipboard.    (For information on Copy, 
see Copying Text.)    Next, move back to the edit window and place the carat at the position you want 
the text to appear.    Then choose Paste from the Edit menu, and the text from the Clipboard will be 
inserted.
For information on InterNav's additional Paste commands, see Custom Editing Features.
For information on inserting a text file in your message, see Importing Text Files.



Edit Window Formatting

To insure you have a nicely formatted message, it is best to let InterNav handle the formatting or your 
message automatically.    The settings that control formatting are located in the Preferences dialog box.   
These settings can be changed at any time, by choosing Preferences from the Options menu.
If you want InterNav to handle formatting, set the Word Wrap Message Edit field to Yes in the 
Preferences dialog box.    By setting this field to yes, as you type, text will automatically wrap to the next 
line when you reach the end of a line.    The only time you should press the Enter key is to start a new 
paragraph.
If you want to format messages yourself, set the Word Wrap Message Edit field to No in the 
Preferences dialog box.    As you type, you will need to end each line by pressing the Enter key.    Also, 
please keep in mind that no line should contain more characters than the value you have set in the 
Transmitted Message Width field of the Preferences dialog box.    (The edit window will not reflect the 
width you have set.)    If you enter a line that exceeds this value, it will be split in two lines when the 
message is sent to DELPHI.



Custom Editing Features

In addition to the standard Windows Paste command, InterNav offers two additional commands:    Paste
Formatted, and Paste Quoted.
The Paste Formatted command automatically formats the selected text into a paragraph.    When the 
message is transmitted to DELPHI, the line endings will automatically wrap at the Transmitted 
Message Width set in the Preferences dialog box.
The Paste Quoted command is generally used to insert text that is from another message.    This 
command will format the text into a paragraph and start each line with a special character, or string of 
characters, such as:
>The inserted text will appear in this form.

NOTE:    Many people use the ">" sign to show text being quoted from another message.    If you wish to 
use something else, choose Macros from the Options Menu, and change the value in the Quoting 
String field.

To use any of the Paste commands, select the text with the mouse that you wish to import, and choose 
Copy from the Edit menu.    Then, move back to the window where you are composing the message, 
position the carat at the point where the text should be inserted, and choose the appropriate Paste 
command from the Edit Menu.



Importing Text Files

You may find there are times when you want to compose the text of a message off-line, or incorporate a 
file into the message you are composing.    To put a file in the edit window, place the carat at the point 
you wish to insert the file, and then choose Import Text from the File menu.    You will be prompted for 
the file name, and after selecting the name, the file will be displayed in the edit window.

NOTE:    When using this command, make sure the Transmitted Message Width field in the 
Preferences dialog box is set to a number that will accommodate the longest line in the file.



Common Hayes Commands

+++ Escape
AT Attention
DP Dial Pulse
DT Dial Touch-tone
E0 Echo Off
E1 Echo On
H0 Hang up (go on hook)
H1 Go off hook
M0 Speaker always Off
M1 Speaker ON until CONNECT
M2 Speaker always ON
Q0 Result codes displayed
Q1 Result codes suppressed
V0 Numeric result codes
V1 Verbal result codes
Xn Result code set
Z Reset to software defaults



Xn
Where n represents the numeric digit for the result codes you want returned by the modem.    With most 
modems, 0 represents the basic code set, but please consult your modem's user guide for the various 
other values that can be used.



Editing in InterNav
Copying Text
Using Edit Windows
Custom Editing Features
Edit Window Formatting
Importing Text Files



InterNav Scripts
See Also:
InterNav's command scripts are ASCII text files.    You can use the File commands, or any ASCII editor 
that you wish to compose or edit script files.
The script file is interpreted one line at a time.    The line can be variable length and must end with a 
CR/LF sequence.    The maximum line length is 1023 characters, including the CR/LF.    There can be 
only one command per line and the complete command must fit on that line -- it can NOT be continued 
on the next line.
A line of text can be blank or can contain a comment or command.    Comments can not appear on the 
same line as a command.    All blank lines and leading space and tab characters are ignored.    Any line 
that does not begin with a legal command is considered a comment.



See Also:
Argument Types
Command Arguments
Command Syntax
Script Commands
Script Limits



Command Syntax

All script commands have the following syntax:
CommandName(ArgList)

Where 'CommandName' is the name of the command (names are not case-sensitive).    The opening 
parenthesis MUST be attached to the command name-- do not include any space between the 
command name and the opening parenthesis.    The 'ArgList' can be either empty, or contain a variable 
number of comma separated arguments.    The following are examples of legal command syntax:

commandname()
CommandName(arg0,arg1)
COMMANDNAME(0,50,"This is a string with spaces")

Please note, spaces are interpreted and the script interpreter reserves the comma character, if the 
comma is not within a quoted string.    For example, this is also a legal command:

CommandName(This is a string, that is two arguments long)
The first argument is "This is a string", the second argument is " that is two arguments long".    It is best 
that you enclose all strings in double quotes to avoid confusion.



Command Arguments

Arguments are interpreted from left to right and can be either literal values, such as 1, 5000, 2200, 
"Hello World", and "\r\n", or variables, such as $(Delay), $(Password), $(FailureCode), or $(CommEol).
The variables must be enclosed with: $().    The dollar sign/open parenthesis introduces the variable and 
the closing parenthesis terminates the variable.    All characters between the parenthesis are considered 
part of the variable name.    The variable should contain only the letters A-Z or numbers 0-9.    The 
variable name is not case-sensitive, thus "$(Variable)" and "$(VARIABLE)" resolve to the same variable.
The variables are stored in the Internav.Ini file under one of the Profile sections.    There will be a 
minimum of one Profile section, and that section is [default-Profile].    The standard variables in this 
section are:

$(UserID)
$(Password)
$(NetworkID)
$(LogonScript)
$(LogoffScript)
$(PhoneNumber)
$(DialPrefix)
$(Listings)
$(Editor)
$(ControlFilter)
$(Naplps)
$(Prompts)
$(Terminal)
$(Pagelength)
$(Pagewidth)
$(Port)
$(Speed)
$(DataBits)
$(StopBits)
$(Parity)
$(CodeAT)
$(CodeEscape)
$(CmdDial)
$(CmdHangup)
$(CmdSetup1)
$(CmdReset)
$(ResultOK)
$(ResultConnect)
$(DisplayWordWrap)
$(EditWordWrap)
$(DisplayFont)
$(EditFont)



$(EditLineWidth)
$(CommEol)
$(NetworkPrompt)
$(NamePrompt)
$(PasswordPrompt)
$(TriggerString)
$(WakeupChar)
$(WakeupResponse)

You can add any number of variables to the section and use them in scripts by simply editing Internav.Ini
to include the variable in this form:

VariableName=Value
You will have to place the new variable in the proper section.    For example, if you use only the Default 
Profile, you will need to place your variable in that section.    If you use a different Profile, you will have to
place your variable in the appropriate section.

NOTE: Variables may be empty, that is "VariableName=" represents a legal value (an empty string).    
Variables must, however, exist.    Any command that references a nonexistent variable will fail and cause
the termination of the script file.    Variables may contain other variables.

String arguments may contain the following "C" language escape sequences:
Escape ASCII ASCII
Sequence NAME VALUE
---------------- ---------- -----------
\a BELL 7
\b BACKSPACE 8
\f FORM FEED 12
\n LINE FEED 10
\r CARRIAGE RETURN 13
\t TAB 9
\\ BACK SLASH 92
\" DOUBLE QUOTE 34

In addition to the escape sequences listed above, you can also use the "\xnnn" sequence, where "nnn" 
is a maximum of three (3) hexadecimal digits that represents the eight bit character.    For example, "\x5" 
represents the ASCII ENQUIRE character, which has an ASCII value of 5.    Please note, the 
hexadecimal escape sequence will evaluate a maximum of three (3) hexadecimal digits, so if you wish 
to follow the ENQUIRE character in the above example with, say the digit "8", you should code: "\
x0058", which will be interpreted as "<ASCII ENQUIRE CHARACTER>8"
All arguments are interpreted in the following sequence.    All variables are resolved, including nested 
variables; the argument is "cooked" (that is, all "C" escape sequences are converted to the proper 
characters).    For example:

Name=foobar
CommEol=\n
Puts("$(Name)$(CommEol)")

will resolve to:
Puts("foobar<ASCII LINE FEED CHARACTER>")



Argument Types

There are four argument types used by InterNav:    Numeric, String, Boolean, and Time.
Numeric arguments are decimal digits representing a value that is used as an identification or a counter.
For example, each WatchPoint has an identification number and a maximum count.
String arguments are just that, strings of characters that are treated as one item.    For example, to 
display a string in InterNav's status bar, you can use the following:

Show("Hello World!").
Boolean arguments represent either a TRUE or FALSE value and are used to tell the command script 
interpreter whether or not to abort the script because a command failed.    The values that can be used 
for Booleans are:

TRUE FALSE
---------- -----------
On Off
Yes No
1 0
True False

Time arguments are decimal digits that represent the number of milliseconds of time to work with.    
There are 1000 milliseconds per second.    For example, to pause a script's execution for 5 seconds, you
would use the following command:

Wait(5000)



Script Limits

InterNav's scripts do have some limits built in.    Those limits are:
Commands are limited to 20 arguments, and a maximum length of 1023 characters including the CR/LF.
Both variable names and their values are limited to 127 characters.
Watch limits are:

WatchPoints 50
Strings 200
String Space 2048



Script Commands

Select the command you wish to see information on.    Use the scroll bar to view entries not currently 
visible on the screen.

CloseComm
Debug
Gets
LocalEcho
ModemPuts
OnLine
Puts
Return
Screen
SendBreak
SetDelay
Show
Silence
Watch
Wait



CloseComm()

CloseComm() closes the communication port and sets the locus to Off-line.



OnLine()

Online() is used in conjunction with the IgnoreCarrier variable and is used to tell the communication 
engine that you are on-line.    You should make a call to OnLine() after you have connected to DELPHI.



Puts(String)

Puts() outputs the string argument to the communication port.

NOTE:    Use this command to output strings such as your Name and Password.



ModemPuts(String)

ModemPuts() outputs the string argument to the communication port with a delay between each 
character output.    The delay defaults to 250 milliseconds, but can be changed with the SetDelay() 
command.

NOTE:    Use this command when sending commands to your modem.



Gets(String,Time,Boolean)

Gets() is used to search the characters from the communication port for a specific string.    Gets() will 
suspend execution of the script until it either detects a string of characters that matches "String" or the 
amount of time designated by "Time" has elapsed.
The script will continue execution if Gets() detects the string within the allotted time.    If Gets() times out 
while waiting for the string, it will continue execution of the script only if "Boolean" is FALSE, otherwise it 
will abort the script and return a failure code to InterNav.

NOTE:    Use this command to watch for strings such as the CONNECT string.    String comparisons are 
case-sensitive.



Show(Null | String)

The Show() command will display the "String" in InterNav's status bar, if the "String" exists.    If a "String"
argument is not given, InterNav's status bar will be cleared.    The "String" will also be displayed in the 
Terminal window.    If the "String" argument is not given, the Show() command will send a blank line to 
the Terminal Mode window.

NOTE: Use this command to keep the user updated.



Screen("On" | "Off" | "Clear")

The Screen() command controls how the Terminal window reacts to characters read from or written to 
the communication port.    If the argument is "On", the Terminal    window will display communication port 
activity.    If the argument is "Off", the Terminal window will not display the activity.    If the argument is 
"Clear", the Terminal window will clear itself of all characters and position the cursor in the upper left 
hand corner of the screen.

NOTE: Use this command to hide the transmission or reception of sensitive data, such as the user's 
password.



LocalEcho(Boolean)

LocalEcho() tells the Terminal window whether or not it should supply the echo of transmitted 
characters to the screen.    If "Boolean" is true, the Terminal window will supply the echo.    If "Boolean" is
false, the Terminal window will assume the host will echo the characters.

NOTE: It is faster to have the Terminal Window supply the echo.



Debug(Null | String)

The Debug() command is used to open and close an ASCII debug trail file.    If "String" is supplied and is
a legal filename, debugging information will be written to that file.    Call Debug() with no arguments to 
close the debug trail.



Silence(Time)

The Silence() command will suspend execution of the script until the allotted "Time" of silence (no 
characters have been received by the communication port) has elapsed.

NOTE: Use this command to suspend execution of the script if you need to wait for the communication 
line to be idle.



Wait(Time)

Wait() will suspend execution of the script until the allotted "Time" has expired.

NOTE:    Use this command if you need to wait between commands.    For example, if you need to wait a
certain amount of time between the CONNECT message and sending a command to the network.



SendBreak(Time)

SendBreak() will put the communication port in a BREAK condition for the allotted "Time".

NOTE:    Use this command if you need to "wakeup" the network with a BREAK.



SetDelay(Time)

SetDelay() is used to set the ModemPuts() character delay.

NOTE:    Use this command to slow down the communication with your modem's command mode.    If 
your modem is not receiving all characters sent to it, bump this value up (it defaults to 250).

cation.



Return(String)

The Return() command aborts the execution of the script and returns an error code to InterNav.    
"String" is an optional description of the reason for returning from script processing. If "String" is 
supplied, "String" will be displayed in a dialog box. If "String" is not supplied, then the standard 
diagnostic message will be displayed. "String" is limited to 253 characters.

NOTE:    Use this command to abort the script if, for instance, you detect a "NO CARRIER" or "BUSY" 
string from your modem.



Watch(Time)

The Watch command is a multi-part function that is used to scan the characters read from the 
communication port for a variety of strings.    Each string is associated with a block of commands that will
be executed should the Watch detect the string.    The Watch block MUST begin with a WatchStart() 
command and terminated with a WatchEnd() command.
The Watch is analogous to a multitude of IF statements nested inside a WHILE loop.    The syntax of    
the Watch is:

WatchStart(Time)
WatchPoint(Numeric,Numeric,String,...)

Command()
...

WatchPoint(Numeric,Numeric,String,...)
Command()
...

...
WatchEnd()

The Watch will be active until one of the following occurs:
The allotted "Time" of silence has expired.
A WatchExit() command is executed.
All WatchPoints() have been deleted with WatchDelete() commands.
A Return() command is executed.

All commands that follow a Watch block will be executed once the Watch has terminated.
The WatchPoint() command can only be used within a Watch and is used to associate a block of 
commands with certain strings.    The syntax for the WatchPoint() is:

WatchPoint(Numeric,Numeric,String,...)
Where the first "Numeric" value identifies the watch point and can be any value between 0 and 49.    The
second "Numeric" value represents the maximum number of times the watch point's commands should 
be executed.    The"String" is the string of characters to associate with the block of commands.    You can
associate up to 18 strings to watch point.
The block of commands which are associated with a watch point are all the commands which follow the 
WatchPoint() command up to, but not including, a WatchPoint or WatchEnd command.
The following is an example of one watch point:

WatchPoint(0,5,"ERROR","NO CARRIER")
Show("Error or No Carrier Detected");
Return()

In the example listed above, the strings "ERROR" and "NO CARRIER" are associated with the Show() 
and Return() commands.    That is, if either the string "ERROR" or "NO CARRIER" are detected while 
the Watch is active, the Show() and Return() commands will be executed.
You can use the WatchDelete() command to disable a watch point.    The syntax for WatchDelete() is:

WatchDelete(Numeric)
Where "Numeric" is the value that identifies the watch point to delete.    The Watch will terminate if you 
delete all watch points.    You should use the WatchDelete() command to disable a watch point that may 
encounter its "String" more than once, but should only be executed the first time it sees the "String".



The WatchExit() command has no arguments and is used as a convenient way to terminate the Watch.  
You can use this command instead of deleting all the watch points individually.





tool bar

A row of    buttons located at the top of the window.



button

A control that is painted with a picture and/or a label.    Buttons are used to execute commands.



scroll bar

A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible. 
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.



option button

A small round button that appears in a dialog box and is used to select an option.    Within a group of 
related option buttons, you can select only one button.



status bar / locus panel / status panel

A line at the bottom of the application workspace that displays information to you about your current 
state and position.    The status bar is divided into two areas; the status panel on the left, and the locus 
panel on the right.



Keyboard Navigation Keys

Down Arrow Moves down one line
Page Down Moves down one window page
End Moves to the last line in the list
Up Arrow Moves up on line
Page Up Moves up one window page
Home Moves to the first line in the list



      Help button
A button located in the MDI window.    Click on this button to display the help topic for the window.



      Help button
A button located on a tool bar.    Click on this button to display the help topic for the tool bar.



      Help button
A button located in a dialog box.    Click on this button to display the help topic for the dialog box.



      Stop button
A button located on the Terminal tool bar.    Click on this button to stop the execution of a script.



      Go Back button
A button located on the Mail tool bar.    Click on this button to return to the On-line tool bar.



      Internet button
A button located on the On-line tool bar.    Click on this button to go to the Internet Services Menu.



      Go Back button
A button located on the Internet tool bar.    Click on this button to return to DELPHI.



      Go Main button
A button located on the On-line tool bar.    Click on this button to return to the DELPHI main menu.



      Go To button
A button located on the On-line tool bar.    Click on this button to open a list of locations.



      Mail button
A button located on the On-line tool bar.    Click on this button to enter the Email system.



      Addresses button
A button located on the On-line tool bar.    Click on this button to open the E-mail Address Book.



      Logoff button
A button located on the On-line tool bar.    Click on this button to quit DELPHI.



      Logon button
A button located on the Off-line tool bar.    Click on this button to automatically call and sign on DELPHI.



      Register button
A button located on the Off-line tool bar.    Click on this button to call and open a new account on 
DELPHI.



      Options button
A button located on the Off-line tool bar.    Click on this button to display the Options tool bar.



      User button
A button located on the Options tool bar.    Click on this button to store your DELPHI username and 
password.



      Close button
A button located on the Off-line tool bar.    Click on this button to close InterNav.



      View Folders button
A button located on the Mail tool bar.    Click on this button to view a list of your mail messages.



      Send New Mail button
A button located on the Mail Tool Bar.    Click on this button to send a mail message.





Off-line Tool Bar      (See Also)

The Off-line Tool Bar is displayed when you enter InterNav, or end a DELPHI session.



Logon command
Will open the communication port, and execute a script to automatically log on DELPHI.    Once the 
logon script has completed running, the On-line Tool Bar will be displayed.



Options command
Will display the Options Tool Bar to change configuration information, such as fonts or scripts.



Options Tool Bar

The Options Tool Bar is used to change configuration information.



Go Back command
Returns to the Off-line Tool Bar.



Terminal Tool Bar

The Terminal Tool Bar is displayed when a script is executing.



Stop command
Stops the execution of the script.



Internet Tool Bar

The Internet Tool Bar is displayed when you are connected with an Internet site.



Go Back command
Returns to DELPHI and displays the On-line Tool Bar.



On-line Tool Bar      (See Also)

The On-line Tool Bar is displayed when you are connected with DELPHI.



Logoff command

Will log off DELPHI and return to the Off-line Tool Bar.



Mail command

Will enter the Mail system where you can send and receive private mail messages to anyone on 
DELPHI or the Internet.    The Mail Tool Bar will replace the On-line Tool Bar.



Mail Tool Bar      (See Also)

The Mail Tool Bar is used to read and send private mail to other users.



Go Back command

Exits the mail system and returns to the On-line Tool Bar.



See Also:
Entering and Exiting E-mail
Sending Messages
Reading Messages



See Also:
InterNav Basics
DELPHI Account Registration
Connecting To DELPHI



See Also:
Disconnecting from DELPHI
Navigating DELPHI Menus
Moving Around Quickly with Go To
Entering and Exiting E-mail
Adding Names to the Address Book



The Announcements window displays your logon information, the number of new mail messages you 
have, and/or the announcements banner.    It is opened when the logon script has completed running.



The Folders window displays a list of your E-mail messages.    Each message will be listed on a 
separate line showing who the message is from, the date, and the subject.    If you have new messages, 
the list will default to NEWMAIL.    If you do not have new messages, the list will default to MAIL 
displaying previously read messages.    To move between lists, click on the drop down list box to display 
the current lists available, and then click on the name of the message list you want displayed.
To read a message, click on the line that contains the message, and then click on the Read button in 
the window, or press Alt+R.    A message can also be read by double clicking with the left mouse button 
anywhere on the line containing the message.    Use the scroll bar to display entries not currently visible 
in the window.
To remove (delete) a message from the list, click on the entry line to select the message, and then click 
on the Delete button, or press Alt+D.



Reply windows are opened when you Reply to a message.    Since you are replying to a message, you 
can not change the To or Subject fields; however, you can send the message to additional recipients by 
adding their address(es) in the CC field.
To add a recipient to the message, either click on, or Tab to, the CC field.    Type the address, or click on 
the Address button to open the E-mail Address Book to select an address from.    To enter multiple 
addresses, separate each name with a comma.    For example:

address1,address2,address3
When you finish writing the message, click on the Send button, or press Alt+S to transmit the message 
to DELPHI.
To abort the reply, click on the Close button, or press Alt+C.
For additional information on using edit windows, see the Editing in InterNav topics.



From windows are used to display messages that have been sent to you.    The upper portion of the 
message will contain who it is from and the subject with the text of the message following.    Use the 
scroll bars to display any text not currently visible in the window.    To save this message to disk, choose 
either Save As or Export from the File Menu.
If you want to reply to the message, click on the Reply button, or press Alt+R.    A Reply window will 
open to compose your reply.
If you want to send this message to another user, click on the Forward button, or press Alt+F.    The 
Forward dialog box will open prompting you for the address.
If you want to add this address to the Address Book, click on the Address button, or press Alt+A.    The
E-mail Address Book will open with the address entered in.    To accept the addition, choose OK.
When you have finished reading the message, click on the Close button, or press Alt+C.    You will be 
prompted to delete the message.    If you choose Yes, the message will be deleted from your workspace 
and can not be accessed again after the current mail session.    If you choose No, the message will be 
left in your workspace for later reference and can be read again from the E-mail Folder window.



Send windows are opened when you Send New Mail.    Enter the address (DELPHI username or 
Internet address) in the To field, the title of your message in the Subject field, and then compose the 
text of your message.
To enter the address to a message, either click on, or Tab to, the To field.    Type the address, or click on 
the Address button to open the E-mail Address Book to select an address from.    To enter multiple 
addresses, separate each name with a comma.    For example:

address1,address2,address3
To enter the subject of the message, either click on, or Tab to, the Subject field and type the name.
If you wish to send courtesy copies of the message to users, either click on, or Tab to, the CC field.    
Type the address, or click on the Address button to open the E-mail Address Book to select an address
from.
When you finish writing the message, click on the Send button, or press Alt+S to transmit the message 
to DELPHI.
To abort the message, click on the Close button, or press Alt+C.
For additional information on using edit windows, see the Editing in InterNav topics.



Edit Posting windows are opened when you are adding a message to a Forum, or Usenet using the 
DELPHI Usenet reader.    Enter the text by typing, pasting from the clipboard, or a file.
When you are ready to transmit the message, click on the Send button, or press Alt+S.
To abort the command, click on the Close button, or press Alt+C.
For additional information on using edit windows, see the Editing in InterNav topics.



The Terminal window is a VT100 emulator which supports a mouse when you are interfacing with 
DELPHI.    Clicking once on the right mouse button transmits a carriage return.    If you move the mouse 
pointer over a word or number and double click on the left mouse button, that word will be transmitted to 
DELPHI.
The Terminal window also supports copying text to the clipboard.    To copy text, select the text using the 
mouse, and then select Copy from the Edit menu.    Please note, you should not use an accelerator key 
combination to issue the Copy command since you are in a terminal emulation window.    Keystrokes, 
except those used to access InterNav menus, are transmitted to DELPHI.



Cancel command

Aborts the command and closes the window.



CC command

Opens the E-mail Address Book to select an address.



Chat Mode command

Opens a chat buffer window at the bottom of the screen to type your messages in when you are in a 
Conference.



Delete command

Removes the message from your workspace.



Forward command

Sends the message to another user.



NewLineMode command

Toggles VT100 NewLine Mode



Read Message command

Displays the selected message.



Reply command

Opens a window to comment to the current message.



Send command

Transmits the message.



To command

Opens the E-mail Address Book to select an address.



Help command

Opens the help system and displays the help topic for the Current MDI window.



InterNav Edit Windows:
Edit Posting
Send
Reply



InterNav MDI Windows:
Terminal
Edit Posting
Folders
From
Send
Reply
Announcements



See Also:
Reading E-mail
Replying to E-mail
Forwarding E-mail
Saving E-mail




